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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i
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1  Apps-Common Videos

Cross-Product Features | Use help to answer your
questions  

Watch video
 

You have a question? Oracle Help Center has the answer.

Click Resources.

Click Documentation.

You can get there from Oracle.com by opening the Resources menu and selecting Documentation. Or, enter the simple
URL docs.oracle.com. We recommend you bookmark this page for future use.

In the browser address bar, enter docs.oracle.com.

From the Help Center home page, click Fusion Applications Suite.

Click Fusion Applications Suite.

Content in Help Center is “cumulative”, in that it includes discussions of all product features, including descriptions, how
to set up, configure, extend, and use. Cloud applications are grouped into product categories. Choose the area you want
to learn more about. For example, Financials.

Click Financials.

Here you’ll find the latest help for Oracle Financials, but you can also select an earlier update.

Highlight the Select your update: drop-down list.

Click the All Books link to see all the Financials books.

Click All Books.

Scroll to see all the books. Or optionally, select a category to filter books by role.

Click the View drop-down list.

When you find the right book, you can open it up.

Click the Using General Ledger link.

You can also browse content by task.

Click Use.

These pages highlight some of the most common tasks and take you directly to the part of the book that covers the
task.

Click the Manage Budgets link.
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Alternatively, you access topics in Help Center through Search.

In the Search field, enter budget upload.

Where you’re at in the Help Center determines the search filter, which tells you the scope of the search. For example
within a guide, or across all cloud applications. Here, because we searched from a Financials page, the results are
specifically for Financials. Note the search results include the same topic you navigated to earlier.

Thanks for watching.

Cross-Product Features | Learn about release updates
using readiness material  

Watch video
 

For readiness material, go to oracle.com/readiness.

Enter oracle.com/readiness in the browser address bar.

Or, if you’re already in Oracle Help Center, find your cloud application, then select Cloud Readiness / What's New.

Click Supply Chain & Manufacturing.

Click the Cloud Readiness / What's New link.

Readiness material tells you what’s new and changed in a release update, and gives you other information to help you
prepare for the update.

You might start by creating a custom report, to get a list of new features for the specific products and modules that you
select, in the release updates that you select.

Click Create Custom Report.

The custom report opens in a new tab.

This report format is helpful because you can filter the content. For each feature, there’s a description, key dates, and a
summary of any actions required to enable the feature. You can also click a feature name to get more details.

Go back to the tab displaying the Cloud Applications Readiness page.

The feature listing report is similar, but it includes features for all products in all recent release updates.

You can also open a What’s New document to directly get to details about the features in a specific product and release
update.

Click the Demand Management What’s New 24D link.

Let’s browse the features and take a look at one of them.

Expand Demand Management.

Expand Replenishment Planning.
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Click Use a Supply Plan as a Supply Schedule in a Multiechelon Replenishment Plan.

To see all the features, click Expand All.

Click the Expand All icon.

The Feature Summary shows you which features are delivered disabled or enabled by default.

Click Feature Summary.

Disabled features require you to take action to make them available to end users.

Now, let’s check the Features with Opt In Expiration to see when a feature from any product is no longer optional.

Click Features with Opt-In Expiration.

You might have to take additional action to make the feature ready for users to use.

Finally, you can also watch readiness demos, see what readiness material has been added or updated this month, and
find information about bug fixes and known issues.

Click Demos.

In the All 2024 Demos section, click the Supply Chain & Manufacturing Demos link

Thanks for watching.

Cross-Product Features | Get help in the application  

Watch video
 

In this tutorial you’ll learn how to find help.

This is the first time I’m using this page, so I’m looking for some help.

Click Procurement.

Click Purchase Requisitions.

Most pages have help, which we can get to using help icons like this one.

Highlight Help icon next to the Requisitions page title.

Let’s take a look. I think this has what I’m looking for.

Click the Help icon.

Click the Requisition Item Search Options link.

This opens up in a new browser tab, so I can keep it open while I work. We’re looking at a book in the Oracle Help Center.

I can use the table of contents or the search to find other info in this book.

Highlight the table of contents on the left, then scroll up and highlight the Search field.
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I can also use these links to jump to a specific section of this topic that we’re on, and I have the option to hide or show
this panel at any time.

Click Expand Search Options: Stemming, Fuzzy and Begins With.

Click the Expand All icon.

Also, my boss had told me that I can find our best practices and policies in the help window. Let’s go back and see.

Go back to the Help window and click Best Practices and Policies.

This is help that my company added. Here, we can do things like email the info to others.

Now, suppose you don’t see any help icons on a page. First, check if they're hidden. If they are, you'll see Show Help
Icons in this menu. Click that to reveal the icons.

Open the Settings and Actions menu and click Hide Help Icons.

Click Show Help Icons.

But some pages don't have any help icons. In that case, you can always click Applications Help to open the Oracle Help
Center.

Click Applications Help.

Go to your cloud service or use the search to find the information you need.

Highlight the Procurement link and then the Search field.

Thanks for watching.

Cross-Product Features | Add your content to a help
window  

Watch video
 

Hello my name is Tanya. In this tutorial I’ll show you how to add your content to a help window.

Let's start by going to the page where we'll add help.

Click Procurement.

Click Purchase Requisitions.

Here's the help window for this page, and because I have the right admin privileges, I can click here to add or change the
links in the window.

Click the UAP for the page, and then click the Manage Help Content link.

First, I want to add my own help and link to it from the help window.

Click the Create icon.
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I can add help in three ways: upload a file, enter my content in this window, or link to a web page. I want to use the text
editor here, so I'll leave Text as the help type.

Open the Help Type LOV to show the options, and then select Text.

Let’s also leave the status as Active so that my link shows up in the help window.

Highlight the Status field.

Next we have the title, which is the text for the link that'll appear in the help window.

In the Topic Title Field, enter Best Practices and Policies.

Finally, I enter my help content, and save my work.

Enter or paste the contents of the help topic into the rich text editor field.

Click Save and Close.

So now we see the help I just added, and it’s already there on the help window.

Highlight the row with Company Policies.

Close the Manage Help Content dialog box, then click the Help icon and highlight the Best Practices and Policies link.

My help is looking good!

Click the Best Practices and Policies link.

Besides adding my own help, I can also hide what’s already there, let’s say this one.

Go back to the Help window, click Manage Help Content and select How You Set Your Preferences to Enable
Requisition Creation.

Inactive help won’t appear on any help window, but we can always change it back later.

Click Change Status and select Inactive.

Click Save and Close.

Now we see that the help is inactive, and we don’t see the link any more.

Highlight the inactive topic.

Close the Manage Help Content dialog box.

Click the Help icon. Add an arrow to indicate where the now hidden link used to be.

I can also hide my own help, or change my content at any time.

Click the Manage Help Content link. Click to select the Best Practices and Policies topic, then click the Edit icon.

Highlight the Status option and then the text editor.

Click Cancel.

We can also link to help that was already created elsewhere. Then I’ll have many links here and I can reorder them. But
for now, I’m good to go!

Highlight and hover over the Select and Add icon, and then highlight the Reorder button.

Thanks for watching.
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Cross-Product Features | View analytics and reports  

Watch video
 

Hello my name is Mike. In this tutorial, you’ll take a look at how to view analytics and reports.

On the home page, you can find analytics in infolets,which show key information related to your work.

In the Analytics section, click the Succession Plan infolet

You can click infolet analytics and Key Performance Indicators to drill down for more details.

The Reports and Analytics work area displays the analyses and reports that you have permission to access. You start by
seeing the items you've marked as favorites.

Click the Navigator icon and select Tools > Reports and Analytics.

You can search for the items you want to see, and you can limit your results to reports, analyses, or dashboards. In the
autosuggest list, you can filter on favorites, recent items, or recent searches.

Click Filter and select Analysis.

In the Search field, enter Workforce and click Search.

If you use this analysis often, mark it as a favorite.

Click the Add Favorites icon for the Workforce Performance Details analysis.

An analysis queries against your company's data and gives answers to your business questions. Here, you not only see
the analysis, but you can also get the data in other formats.

In the Workforce Events by Month row, click the More icon and select View.

Click the Export link to view the export options.

Instead of searching, you can also browse through the folders to find a dashboard. Navigate the folder hierarchy until
you find the analytics you want to view.

Click Done.

Click Shared Folders and navigate to Human Capital Management > Workforce Management > Transactional Analysis
Samples > Workforce Events.

A dashboard contains analyses and other content, which are presented on one or more pages.

In the Workforce Events by Year row, click the More icon and select View to display the dashboard.

You can use dashboard prompts to narrow down the information that's shown on the dashboard.

Expand the Action Name list.

Deselect all columns, then select Hire.

In addition to an analysis or a dashboard, you can also use a report. A report shows you data in a predefined format
that's optimized for printing.
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On the Reports and Analytics page, click Shared Folders and navigate to Human Capital Management > Workforce
Management > Human Resources Dashboard.

Highlight the Person User Dashboard report.

You can view the report on screen. And if you want to print this report, you can save it as PDF.

In the Person User Dashboard report row, click the More icon and select View.

Click the View Report icon and highlight the PDF option.

And, that’s it! Thanks for watching.

Cross-Product Features | Create an infolet  

Watch video
 

Hello my name is Mike. In this tutorial I’ll show you how to create an infolet.

An infolet is a small interactive widget that gives you key information and shows you what's going on in the areas you
work on. You might also find something that you need to follow up on.

Start on the Home page. Scroll down to view the Analytics section.

Now let’s create an infolet. First, I must activate a sandbox that has the Page Composer tool with the Site context layer. I
can test my new infolet in the sandbox before I make it available to users.

Click the Navigator icon and select Configuration > Sandboxes.

Highlight the Infolets Sandbox sandbox.

Click Enter Sandbox.

Let’s go to the infolet page that we’ll add an infolet to. I’ll start by selecting Edit Pages. Then, I’ll create a new infolet, and
add information in it.

Click the Home icon and scroll down to the Analytics section.

Click the General Accounting Infolets tab.

Open the Settings and Actions menu and select Edit Pages.

First, I'll enter the title. Now I'll specify the front dimensions. I'll enable the back view and the expanded view. The back
view automatically gets the same dimensions as the front view, and the expanded view should be larger.

In the Analytics section, click the Infolet Repository icon.

Click Create Infolet.

Enter the infolet title as Balance.

Specify the dimensions for the front view as 2X1.

Enable the back view and the expanded view. Specify the dimensions for the expanded view as 2X2.
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Click Save and Close.

Here I see my new infolet.

Highlight the new infolet.

I'll add some content to it. I'll start by navigating to the Reports and Analytics folder, then I’ll click BI PresentationServer,
shared folders, then continue navigating through the folders. I'll select and add a report to the infolet’s front view.

On the new infolet, click Add Content.

Open the Reports and Analytics folder, and browse to Balance Sheet folder.

Click the Add icon.

Click Close to close the Add Content window.

To provide detailed information, I can also add a link to the detailed report.

Click the Actions icon and select Link Detailed Report.

Now I'll add content to the detailed report page. I'll navigate to the Reports and Analytics folder again, select a report,
and add it. I’ll click Done when finished, then navigate back to my infolet to add more.

On the Detailed Report page, click Add Content.

Open the Reports and Analytics folder and select the compoundView!1 value.

Click the Add icon to add it to the infolet.

Click Close to close the Add Content window.

Click Done.

Now, using the same steps as before I'll find another report and add it to the infolet's back view.

Click the Back View icon.

Click Add Content.

Open the Reports and Analytics folder and select the Income value.

Click the Add icon.

Click Close to close the Add Content window.

Now I'll add a report to the Expanded view. As before, I'll navigate to the Reports and Analytics folder, select, and add
the appropriate report to the expanded view.

Click the Expanded View icon.

Click Add Content.

Open the Reports and Analytics folder and select the Cash value.

Click the Add icon in the first report.

Click Close to close the Add Content dialog box.

Click the Collapsed View icon.

Click the Front View icon.

8



Oracle Fusion Cloud Applications
Applications Common Videos Questions and Answers

Chapter 1
Apps-Common Videos

This infolet has everything we need now. I’ll click Close, and review my changes.

Click Close.

Now I’ll preview the infolet before I publish the sandbox. Here’s the front view. I’ll drill down to the detailed report.

While the front view is displayed, click anywhere in the infolet area to drill down to the detailed report.

Click Done.

Now let’s look at the back and expanded views. This looks great now!

Click the Back View icon.

Click the Expanded View icon.

Let's publish the sandbox so that everyone can use my new infolet! Now I'll navigate back my infolet to verify that it is
available for use.

In the Infolets Sandbox field select Publish.

Click OK.

Click Publish.

Here's my new infolet. And we are done.

Go to the Analytics section and click the General Accounting Infolets tab.

Show the front, back, and expanded view of the new infolet.

Thanks for watching.

Cross-Product Features | Submit a scheduled process  

Watch video
 

Hello my name is Mike. In this tutorial you’ll learn how to submit a scheduled process and see the output.

To start, go to the Scheduled Processes work area, and start here to submit a process.

Click Tools.

Click Scheduled Processes.

Click Schedule New Process.

The process I want to run isn’t listed here, so I’ll search for it.

Click the Search: Name drop-down list and then click Search.

In the Name field, enter Trial Balance Report and then click Search.

Here’s the one I want, so I’ll select it.

9
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Many processes have parameters that control which records are included or what the process does. In this case, I’ll leave
the default values.

There are more options in Advanced mode. For example, I can run this process at a specific time or on a recurring
basis…or just have it go as soon as possible.

Click Advanced.

Click the Schedule tab and select the Using a schedule and As soon as possible options.

This process generates output, which I can get it in PDF or any of these formats.

Click the Output tab.

Click the Add Output Document icon.

Finally, I want to let my manager know if this process errors out. So I’ll set up a notification.

Click the Notification tab.

Click the Create Notification icon.

Enter values in both fields and click OK.

Now I’ll submit the process.

Click Submit.

Click OK.

I can refresh to see the latest status for my process. Now that it’s done successfully, I’ll select it.

Click the Refresh icon.

Select the row with Trial Balance Report with Succeeded status.

I’ll open the output here, and I can also download or print the PDF. And that’s it!

Scroll down to the Output section and click the link in the Output Name column.

Thanks for watching.

Cross-Product Features | Configure the digital assistant
for cloud applications  

Watch video
 

Use your digital assistant to improve your employee productivity by leveraging conversations to complete tasks and
answer queries.

As a primary cloud administrator, you get the Oracle Cloud user account credentials through a Welcome email. Open
the Oracle cloud URL in a browser. In the URL, the tenant name is your cloud account name. To change the primary
administrator, you must provide an authorization email from a company senior executive in a technical service request.
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Open https://cloud.oracle.com/identity/domains/?tenant=icorinternal&domain=Default&region=us-phoenix-1in your
browser.

Sign in to your Oracle cloud account using your cloud account user name and the password that you configured during
the cloud account activation.

On the Oracle Cloud Account Sign In page, enter your cloud account user name and password and click Sign In.

Open your domain.

On the OCI Console, in the left navigation menu, in the Compartment field select icorinternal (root).

Open Oracle Cloud Services from the Identity domain menu to view all the instances. Now find the IDCS application for
your digital assistant platform. The application name will probably start with idcs-oda.

In the Identity domain menu, click Oracle Cloud Services.

Search for and open the application that starts with idcs-oda.

Assign appropriate roles to yourself and other users to access the digital assistant platform. For example, assign
yourself the ServiceAdministrator role to have full privileges, including viewing detailed audit information and purging
data, within the digital assistant platform. For users who need to have full access to build and test skills and digital
assistant, assign the ServiceDeveloper role. And for those users who need to evaluate the digital assistant and skills and
view the business analytics, assign the ServiceBusinessUser role.

From the Resources menu, click Application Roles.

Click the ServiceAdministrator role and then click to expand that role.

Click the Manage link for Assigned users.

In the Manage user assignments dialog box, scroll down and click Show available users.

In the Available users section, search for and select the user name dauser1.

Click Assign.

Now find the digital assistant platform URL. You can also share this URL with team members.

In the idcs-oda application, in the Resources menu, click OAuth Configuration.

In the Configure application APIs that need to be OAuth protected section, copy the URL from the Primary audience
field. Use the URL to open the digital assistant platform UI. Search for the latest FADigitalAssistant from the Skill store.
The Skill store has all employee-facing skills for Fusion Applications. Click the Version icon and pull the latest version.

In a separate browser tab, paste the copied URL to open the idcs-oda application.

Enter your fusion application user login credential.

Click the Navigator icon and select Development > Store.

In the Skill Store, search for FADigitalAssistant.

In the FADigitalAssistant section, click the Version icon.

In the FADigitalAssistant section, click More icon and select Pull.

Click Pull.

When you pull FADigitalAssistant, the digital assistant usually gets trained automatically. If you make changes to your
skills or the training process fails, you’ll need to manually train the digital assistant. To train it manually, select the digital
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assistant that needs to be trained. Click the Train button, leave the Trainer Tm option selected, and submit. You can test
the FADigitalAssistant using the Preview option.

Click Digital Assistant.

Open the FADigitalAssistant that is draft state FADigitalAssistant_Extended_SD by clicking its tile.

Click Train, leave the Trainer Tm option selected, and click Submit.

Click Preview.

On the Conversation Tester page, in the Type Here text field, enter hello and press ENTER.

Now the Digital Assistant for your Fusion Cloud Applications is ready to use. Thanks for watching.

Cross-Product Features | Configure Oracle web channel
and set up digital assistant to work with the channel  

Watch video
 

In this tutorial, I'll show you how to configure Oracle Web Channel and set up Oracle Fusion Cloud Applications Digital
Assistant to work with the Oracle Web channel. Sign in to Fusion Applications using the link and Single Sign-On
credentials that your company gave you.

Open the URL to the Oracle Fusion Cloud Applications in your browser.

Sign in using your SSO credentials.

Now Navigate to the Setup and Maintenance page, then navigate to the Manage Digital Assistant task.

Click Navigator icon and select My Enterprise > Setup and Maintenance.

Click the Setup drop-down list and select the Financials offering.

In the search field, enter and select the Manage Digital Assistant task.

On your Idcs-oda application, select Channels from the Development menu and click Add Channel.

Click the Navigator icon and select Development.

Click Channels.

Click Add Channel.

Now let’s create a channel by entering the channel details. Give your channel a name and a description. Choose Oracle
Web as the channel type. In the Allowed Domains area, enter an asterisk to allow unrestricted access to the channel
from any domain. If you want the channel to communicate only with specific sites, you can enter one or more domains
as a comma-separated list. Enable the Client Authentication Enabled option and set a maximum amount of time for
JWT (JASON Web Token). Because I am allowing unrestricted access, I'll disable the Client Authentication Enabled
option. I'll leave the default Session Expiration of 1440 minutes, which is one day. I could change this if I want to. When
the user's session expires, the conversation stops, and a message notifying the user is sent. Click Create.

In the Create Channel dialog box enter the name and description of your channel. OWC_DigitalAssistant.
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From the Channel Type list, select Oracle Web.

In the Allowed Domains field, enter the URL of your application or enter *.

Deselect the Client Authentication Enabled checkbox.

Optionally, set the availability duration for the Oracle Web channel. The default value is 1440 minutes.

Click Create.

From the Route To drop-down list, search for and select the latest version of FADigitalAssistant to associate it with your
new channel. Enable the channel, then click Reset Sessions. Copy the channel ID or make a note of it. You will need this
channel ID while enabling your digital assistant.

In the Route To field, search for and select the latest version of FADigitalAssistant.

Click the Channel Enabled checkbox.

Click Reset Sessions.

Now configure the digital assistant to work with the Web channel. Sign in to Fusion Applications and navigate to the
Setup and Maintenance work area. Now navigate to the Manage Administrator Profile Values task. Search for the
FA_ENABLE_DIGITAL_ASSISTANT profile option code. Add a new Site profile level, with a profile value of Y, then Save
and close.

Sign in to Fusion Applications.

Click the Navigator icon and select My Enterprise > Setup and Maintenance.

In the Setup and Maintenance work area, select Sales offerings.

Select the Sales Foundations functional area and select All Tasks from the Show list.

Open the Manage Administrator Profile Values task.

On the Manage Administrator Profile Values page, search and select Profile option to enable digital assistant
(FA_ENABLE_DIGITAL_ASSISTANT) profile option.

In the FA_ENABLE_DIGITAL_ASSISTANT: Profile Values section, click the New icon.

From the Profile Level list, select Site.

In the Profile Value field, enter Y.

Click Save and Close.

You can now add the digital assistant to Fusion Applications. First, create a sandbox. Activate the HCM Experience
Design Studio tool, then create and enter the sandbox. Open the HCM Experience Design Studio. Click the Digital
Assistant Configuration tab and enter the network configurations. On the HCM Experience Design Studio page, click
the Digital Assistant Configuration tab and enter the network configurations. The Server URL of the ODA instance is
populated automatically. Enter the Web channel ID that you obtained while configuring Oracle Web channel for your
digital assistant. In the Features and Functionality Configuration section, you can specify other web channel preferences
such as share attachments in the chat window, bot responses in audio. When you’re done making the changes, save the
configurations.

Click the Navigator icon and select Configuration > Sandboxes.

On the Sandboxes page, click Create Sandbox.

Enter a name and description for your sandbox.
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In the All Tools section, select the HCM Experience Design Studio tool that you want to activate and click Create and
Enter.

On the Tools menu, select HCM Experience Design Studio.

On the HCM Experience Design Studio page, click the Digital Assistant Configuration tab.

In the Network Configuration section, enter a server URL of your digital assistant instance where the Oracle Web
channel is configured in Server URL of the ODA Instance field. For example, idcs-oda-88343450fd012b9fb498be0c36-
t0.data.digitalassistant.oci.com.

Note: When you enter a server ODA URL, make sure it doesn't contain https:// or a trailing slash.

In the Web Channel ID field, enter the web channel ID, which you got when you configured Oracle Web channel for your
digital assistant.

Note: When you enter a web channel ID, make sure it doesn't contain any spaces.

Specify other web channel preferences such as enable attachment sharing in the Features and Functionality
Configuration section.

Click Save and Close.

Now, check if your connection is working. The chat window displays the help menu with skills as expected. Once you
publish the sandbox, the Fusion Applications Digital Assistant is ready to work with the Oracle Web channel.

On the Fusion Applications UI, click the Chat icon.

Enter Hello.

Thanks for watching.

Cross-Product Features | Configure the Navigator and
icons on the Home page for navigation  

Watch video
 

Start on the Home page.

In this tutorial, I'll show you how to configure the Navigator and the icons on the home page for navigation. I’ll create a
group and then a page entry to open a custom AppUI that I already created using Visual Builder Studio. But before we
get there, let's take a quick look at the icons you can use to open work areas.

Highlight the work area icons in the Apps section.

Based on the selected tab, you get work area icons for a group of related tasks.

Highlight the Tools tab.

Highlight the work area icons under the Tools tab.

You can also use the Navigator to open the same work areas, which we find under the same groups as the tabs on the
home page.
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Click the Navigator icon.

Highlight Tools. Click Tools.

Now let’s configure the navigation. To begin with, we must activate a sandbox so that we can test the changes and then
make them available to the users.

Click Configuration > Sandboxes.

Create a sandbox, add the Structure tool to it, and then activate it. Or just activate an existing sandbox that has the
Structure tool in it.

Highlight the Configure sandbox.

Click Enter Sandbox.

Now let’s get to work. We’ll create a new group and add page entries in it.

Click the Home icon.

Highlight the area above the global header with the sandbox information.

Click the Navigator icon and select Configuration > Structure.

Give a name to the group and select an icon for it. You may decide to set it as visible and then save and close the group.

Click Create > Create Group.

In the Name field, enter My Group.

Search for and select the icon for the group.

In the Show on Navigator field, select Yes.

Click Save and Close.

We’ll then move a predefined page entry into the new group that we created.

On the Navigation Configuration page, expand the Me group, click the Move To icon for the predefined page entry,
Connections.

Select My Group to move this page entry into the new group, My Group.

Let’s now create a page entry that opens an application built using Visual Builder Studio.

Click Create > Create Page Entry.

Give a name to the page entry and select an icon for it. You may want to place this page entry in the new group you
created.

In the Name field, enter My Page Entry.

Search and select the icon.

In the Group field select My Group.

You can show this page entry on the Navigator and home page.

In the Show on Navigator field, select Yes.

In Show on Springboard field, select Yes.
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And set the page entry to open the application that you created using the Visual Builder Studio. By default, the value of
the Focus View ID would be /index.html. To link your application to v1 VB apps, which are VB Studio pages, select one of
these, ORA FSCM UI, ORA HCM UI, or ORA CRM UI. To link your application to v2 VB apps, which are Unified VB Studio
Pages, select ORA FSCM UI.

In Link Type field, select VB Studio Page.

In the Focus View ID field, enter /index.html.

In the Web Applications field, select ORA_FSCM_UI.

To secure the custom entry in the same way as an existing entry, copy and paste the secured Resource Name value from
an out-of-the-box entry. Note you can’t create a new resource. Select the application stripe as hcm, crm, or fscm.

Highlight the Secured Resource Name and Application stripe fields.

Optionally, enter values for the product family, VB Studio Flow ID, VB Page Name, and VB App UI of your application.

Click Save and Close.

Now we see a new group with its two page entries on the Home page.

Click the Home page icon.

Click My Group.

Highlight the page entries.

And the same on the Navigator.

Click the Navigator icon and show the new group and its page entries on the Navigator menu.

After I publish the sandbox, my changes are now good to go!

In Configuration field on the sandbox bar above the global header, select Publish.

In the Publish Sandbox window, click Yes.

Click Publish.

Thanks for watching.

Cross-Product Features | Sign in and get started  

Watch video
 

Title and music.

Use the link your company gave you to access the Sign In page. Enter your user name and password to open the Home
page.

In the User Name field, enter scott.payrollclerk.

In the Password field, enter the password for scott.payrollclerk.
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Click Sign In.

This is the Home page. Click any of the apps to open that specific work area.

Highlight the Apps section.

You can go straight to some key tasks in the selected group by using the Quick Actions.

Highlight the Quick Actions.

If you can't find the work area you’re looking for in the Apps section, you can use the Navigator. The Navigator is in the
global header, which you can find on every page in the application, including the Home page.

Highlight the Navigator icon.

Click the Navigator icon.

Click to expand Me.

The Navigator contains all the work areas you have access to, arranged in specific groups.

Click to close the Navigator.

The same groups in the Navigator also appear as tabs on the home page.

Highlight the row of tabs.

Click Others.

The Others tab shows a collection of unrelated work areas that aren’t in any other groups. For example, the Getting
Started work area, where you can access videos and other materials to help you get started in the application.

Highlight the Getting Started app.

There are a number of key tasks you can do in the global header.

Highlight the global header.

Use the Settings and Actions menu to set your accessibility preferences and other preferences such as language,
password, and notifications. You can troubleshoot problems if needed and get application help. The options displayed
in this menu depend on your role. For example, if you’re an administrator, you’ll see more options to configure the
application.

Highlight each link as it’s mentioned in the narration.

Click the image in the global header to open the Settings and Action menu.

Close the Settings and Actions menu.

Use the Search field to find specific people or tasks you need to work on.

Highlight the Search field.

Click the Home icon to return to the Home page from anywhere in the application.

Highlight the Home icon.

Click the Favorites and Recent Items icon to bookmark pages or go back to pages you recently opened.

Highlight the Favorites and Recent Items icon.
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Click the Watchlist icon to open a list of items you’re tracking.

Highlight the Watchlist icon.

Click the Notifications icon to open a list of notifications, actions, and approvals you need to act on.

Highlight the Notifications icon.

When you’re done, use the Settings and Actions menu to sign out.

Click the image in the global header to open the Settings and Action menu.

Highlight the Sign Out link.

Thanks for watching.

Oracle copyright and music.

Cross-Product Features | Overview of work areas  

Watch video
 

Hello my name is Mike. In this tutorial I’ll give you an overview of work areas and show you how to get started using
them.

Start on the Home page.

Highlight the My Team tab, then click it.

A work area is a set of pages that provides everything you need to accomplish a business goal. Let's explore a couple of
work areas.

Highlight the work area icons in the Apps section.

Click My Team.

When you open any work area, you see a landing page. Landing pages typically summarize data and let you drill down
to more details.

Highlight the record summary area.

Some landing pages, like this one, have filters you can use to find what you're looking for.

Click Show Filters.

Highlight the Filters pane.

Click Direct Reports and Line Manager.

Click Hide Filters.

You can usually select actions to take on specific records, or open the record to see or edit details on another page.

Click the Actions icon.

Let’s take a look at a different work area.
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Click the Navigator icon and select My Team > Goals.

On this landing page, we can use the search to find what we need. And also select actions to take on specific records.

In the Search Person field, enter Lorenzo Bellino.

Click Search.

Click the Actions icon and highlight Feedback value.

Now let’s see another work area where you get quick access to a set of related tasks.

Click the Navigator icon and select Me > Time and Absences.

On this landing page, you easily see the key tasks you can do in the work area.

Highlight all the boxes you see on the page.

Highlight the Existing Time Cards box and then click it.

Other than filters and searches, there are other ways for you to get to what you need to work on. I signed in with a
specific user role to view the work area with infotiles, which display key information about a set of records.

Click the Navigator icon and select Me > Expenses.

Here you can see records based on the infotile you select.

You can also click links in the infotile to filter the records. For example, you can see the list of items you need to act on.

Highlight the links within the Expense Reports and Expense Items infotiles.

Click the Cash link.

Highlight the record.

Just like we saw with other work areas, here you can also drill down from the landing page to a specific record.

Highlight the first row in the summary table.

Click the date link.

Highlight the Details page.

Click Cancel.

Some pages have tabs on the right, which you can use to perform additional tasks or view reports.

Highlight the panel tabs.

Click the Tasks tab and highlight the links.

Now let’s see a work area, where some pages have tabs on the left, to take us to another page in the same work area.
Now you can go find the many other types of work areas to explore.

Click the Navigator icon and select Risk Management > Surveys.

Click the Surveys tab.

Click the Choice Sets tab.

Thanks for watching.
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Setup | Review feature updates  

Watch video
 

Hi, my name is Mike.

In this video, you'll learn how to review upcoming changes to the existing features available in your environment.

You must have the Configure Oracle Fusion Applications Offerings role to perform this task.

Click the Navigator icon and select My Enterprise > Feature Updates

To start, go to My Enterprise, then select Feature Updates.

The Feature Updates tab shows the features for which a behavior will change in a future revision so you can prepare
accordingly.

For example, a feature that allows you to opt in or out, could:

Change to be always enabled and thereby, prevent you from opting out

Or, the feature could become obsolete and therefore, no longer applicable

Typically you review new features for all enabled offerings but if you want to, you can focus on a given offering, or use
filters to focus on a specific functional area.

The functional area column identifies the functional module or process that the feature change is impacting.

Use the Available In column to identify the release in which the feature was introduced.

You can use the filter to restrict the list to a specific update revision if needed.

Use the Description column to learn about the feature, and click Learn more for additional help topics.

In the Financials row, click the Learn More icon.

A checkmark in the ‘Enabled’ column indicates if the feature is already enabled.

Otherwise, you see the Go to icon, which you can use to take you to the page where you can enable the feature.

The Changes From, Changes To and Changes In columns help you to identify how the behavior will change in the future
and in which update.

A feature might change from allows opt-in to always enabled.

Or, from always enabled to obsolete.

Or, from allows opt-in to obsolete

For example, this feature currently allows me to opt-in.

However, it’ll become obsolete in 21C.

And here's another example – this feature currently allows me to opt-in.

However, it’ll become always enabled in 21C.
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For features that will have a behavior change in the next update, the Change In value will be highlighted to draw your
attention.

Click the Changes To drop-down list.

Click to close the Changes To drop-down list.

Click the Changes From drop-down list.

Click to close the Changes From drop-down list.

You can also use the filters for these columns to focus on changes to or from a specific behavior, or on all upcoming
changes in a specific revision.

Thanks for watching.

Setup | Review and opt in new features  

Watch video
 

Hi, my name is Mike.

In this video, you'll learn how to review and opt in new features after each upgrade of your cloud services.

You must have the Application Implementation Consultant role to perform this task.

If you are not already familiar with how to configure and opt-in Offering features, review the Configuring Offerings
tutorial first.

To start, navigate to My Enterprise, then New Features

Click the Navigator icon and select My Enterprise > New Features.

The New Features tab shows the features that were introduced in the last upgrade.

Enable Help.

In the Customer Data Management row, click the Help icon.

Because I enabled ‘Show Help Icons, the ‘Learn More’ column is displayed.

I want to learn more about this functionality before I opt in.

As shown here, there are many help topics related to this functionality that you can review.

Typically I review new features for all of my enabled offerings but, if I wanted to I could focus on a given offering by
selecting it from the menu.

Click the All Enabled Offerings drop-down list and select Financials.

I can also use filters on the functional area and feature columns to limit the list to a specific functional area or a feature.

In the Functional Area filter, enter common.
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All features that are directly associated with an offering are grouped in a Functional Area with the same name as the
offering followed by the word ‘Common'.

For example, features that are directly associated with the Financials offering show ‘Financials Common’ as their
functional area.

Today I’m interested in the new features introduced for the Expenses functional area in the last update.

In the Functional Area filter, enter Payables.

A checkmark in the ‘Enabled’ column indicates whether or not the feature is already enabled.

Some of the new features will allow you to opt in or out to give you lead time to prepare for their uptake.

‘The Allows Opt-In’ column for those features will show a checkmark.

Other features, which typically represent best practices, are always enabled and will show nothing in the ‘Allows Opt-In’
column.

If a new feature requires setup before it can be used, the Requires Setup column shows an icon.

It is helpful to know if new functionality will require setup so you can plan accordingly even though opt-in may not be
required.

The Changes To and Changes In columns will show you whether the current behavior of a feature will change in the
future.

For example, I see that this feature currently allows me to opt-in.

However, it’ll become always enabled in 21D and I won’t be able to opt it in or out.

Use this information to make appropriate preparation for upcoming change in behavior."

To opt in to a feature, use the go to icon in the Enabled column.

In the Financials Common row, click the Go To icon.

To Enable the highlighted feature, mark the Enable check box.

Click Done to return.

This feature doesn’t require any setup, so it’s ready to use.

Repeat the same steps to enable any other feature you want to use.

Use the Available Features tab if, instead of reviewing only the features that were introduced in the last update, you wish
to review a comprehensive list of all new features that are currently available to use but were introduced through several
updates in the past.

All columns have the same functionality as their namesakes in the New Features tab.

In addition you can use the filter on the Available In column to limit the list of the features to a specific update.

In the Available In filter, enter 20C.

Thanks for watching.
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Setup | Set up offerings  

Watch video
 

Hi, my name is Mike. In this tutorial, you’ll learn how set up an offering.

You must have the Functional Setups User role to set up an offering, and the appropriate application administrator role
to enter and modify setup data. Before you can set up, you must first configure the offering as shown in the Configure
Offerings tutorial. To begin, go to the Setup page.

Click Setup and Maintenance.

You can only set up offerings that you have previously enabled. Enabled offerings are shown in alphabetical order.
Select Workforce Development.

Click the Compensation Management drop-down list and select Workforce Development.

Based on how you’ve configured the offering, all enabled functional areas are displayed in a list. The display order
reflects the sequence in which the functional areas should be set up. The functional areas listed higher up are usually
prerequisites for the setups of the functional areas shown lower in the list.

Highlight upper and lower areas as you scroll.

The shared link indicates that a functional area is used other enabled offerings. Open the link to find out which of the
other offerings are using this functional area. This allows you to evaluate whether or not you have already set up the
functional area as part of setting up another offerings.

Click Shared link for Initial Users, scroll through, then click Done.

An asterisk indicates that setup is mandatory.

Highlight the asterisk column.

When a functional area is selected, the required setup tasks are displayed.

Highlight the Required Task field.

If setup is mandatory for the functional area, then the required setup tasks are shown by default. You can change
the filter to All to show additional tasks that are optional, but you might decide to perform them depending on your
business needs.

Change Required to All and highlight the list below that now shows all tasks.

If a functional area does not have any required setup tasks, all of the setup tasks are displayed. Like Functional Areas,
the display order of the tasks reflects the sequence in which they should be performed. Tasks at the top of the list are
typically prerequisites for the tasks that are lower on the list. The list shows only the tasks that are necessary to set up
the features you opted in when you configured the offering.

Click Workforce Profiles and highlight All Tasks field.

If you change your offering configuration you might need to perform additional setup tasks. To perform a task, just click
on the task name. Here’s where you can enter the relevant setup data. In this case, you don’t have to make any change
to the existing setup.
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Click Talent Notifications.

Return to the task list and continue to perform the rest of the tasks in the list.

Once you finish setting up the offering, you are ready to export the setup and migrate it to production environment.
Watch the Perform Offering Export tutorial next to learn how to export setup of an offering from one environment and
migrate it to another.

Click Cancel.

Thank you for watching.

Setup | Set up offerings with scope  

Watch video
 

Start on the Home page.

If you have a list of tasks that need to be completed, those tasks may require selecting the context -- known as the
scope -- before entering setup data. To begin, open the Setup and Maintenance page.

Click the Navigator icon and select My Enterprise > Setup and Maintenance.

Open the Procurement setup page, select the Organization Structures Functional Area, and then display all the setup
tasks.

In the Setup field select Procurement.

In the Functional Areas list, click Organization Structures.

In the Show field, click All Tasks.

The Scope column displays the value that was selected last. In this case, you haven’t performed one of these tasks
before and therefore no scope is selected. So, select the scope now.

Highlight the Scope column.

In the Task list, Assign Business Unit Business Function row, click Select…

For this task, the scope is Business Unit Business Function.

In the Business Unit field, select Select and Add.

Click Apply and Go to Task.3.

Set up the Business Unit Business Function for the business unit called Vision Retail.

In the Name field enter Vision Retail.

Click Search.

Select it, then save it to add it to the scope.

In the Search Results, click to select Vision Retail Business Unit.
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Click Save and Close.

After you save it, you can enter setup information as needed.

Click Save and Close.

The scope for the task is now set to the value that you selected. You can change the scope at any time by clicking the
scope value and repeat the tasks for the new context value following the same steps.

Highlight the Scope column with the new value.

Thanks for watching.

Setup | Export offering setup  

Watch video
 

Hi, my name is Dee. In this video, you will learn how to export your offering setup. You need the Application
Implementation Consultant role to perform this task. Before you can export, you must first set up your offering as
described in the Setting Up Offerings tutorial.

To start, go to offering Setup.

Click Setup and Maintenance.

You’ve completed setting up Project Execution Management and now you are ready to migrate your setup to another
environment.

Click the Setup drop-down list and Select Project Execution Management.

Create a new export process.

In the Actions menu select select Export > Create New.

Typically you’ll export all setup data of the offering and therefore, select Submit.

Highlight the Submit button.

However, you may decide to filter and export a partial set of setup data. The Scope Enabled column shows which setup
data could be filtered. For example, you’ve set up many business units but want to export only Vision Operations. So
you select Business Unit from the list and then select Add.

Select Business Unit and then click Add.

Search for and select Vision Operations.

If you wanted to limit export to more than one business units, you would continue to search and apply each of those
business units. Once you have the correct list, save and return.

Setup of the business units shown in the list will be exported. If you to want to filter any other scope enabled setups for
your export, repeat the same steps for those Business Objects. Once you’ve completed specifying all filtering criteria for
your export, submit the process.

Highlight the Business Unit Scope table and then click Submit.
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Once you submit the export process, you get a confirmation. The status of the export process is displayed on the Setup
page. Continue to watch the status until the process completes.

Highlight the Latest Export status.

Once the export completes successfully, the Latest Export status shows ‘Ready for download’. Go to the Export Offering
Data Results to download the export file.

Review the summary of the process. Since this process completed successfully, you can start to download the export
file.

Highlight Summary.

If the exported offering has setup tasks for which data will not be migrated through export and import processes,
they are listed here. You have to perform those tasks manually. You must pay particular attention to those that are
recommended as ‘Before Import’. Typically they are prerequisites of other setups. So, if you start the import process on
the other environment without performing these tasks first, your import will fail.

Highlight Manual Tasks.

If errors are returned, the Business Objects table is displayed and the Status Details column shows you the details of the
errors encountered. You would have to review the errors and take the appropriate actions to correct them.

Expand Business Objects.

Since your export does not have any errors, you can download the export file.

Click Download Files.

Save the file when prompted. The filename is the same as the export process name. When the download completes,
you are ready to import the setup into your other instance. Highlight the file name, the Save File option, and the OK
button. If setup data of a functional area changes in the future, you might prefer to migrate only the changed setups
rather than the setup of the entire offering. For example, after your initial export, setup of only Project Execution has
changed, which you need to migrate. Therefore, you select Project Execution functional area and then create a New
Export process. The export process will work the same as described for the offering but will limit the exported setup to
the selected functional area.

Click the Project Execution drop-down list and select Export > Create New.

Thanks for watching! Watch Importing Offering Setup video next to learn how to import setup data from the exported
file.

Setup | Export setup data to configuration packages  

Watch video
 

Hi, my name is Mike. In this video, You’ll learn how to export setup data to a configuration package. You will need the
Application Implementation Consultant role to perform this activity. Before you can export to a configuration package
you must create an implementation project as described in the Manage Setup using Implementation Projects tutorial.

To start, go to Setup and Maintenance.

Click Setup and Maintenance.
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Open the task panel and then go to Manage Configuration Packages.

Open the task panel and click Manage Configuration Packages.

Next, create a configuration package.

Click the Create Configuration Package (+) icon.

To create a configuration package, first select an implementation project. In this case, select Sales Implementation Data.
The task list of the implementation project determines which setup data will be exported.

Select the Sales Implementation Data project.

A default name is assigned to the configuration package based on the name of its source implementation project. You
can change the name to something more meaningful if you want. Go to the next step.

Highlight the Name field.

Click Next.

This table shows what setup will be exported. This list is determined based on the task list of the implementation project
you selected as the source of this configuration package in the previous step.

Highlight the list.

When you select a setup object, if it has any predefined filters, those filter values are shown here. For example, when
you submit this export process, setup data for Applications Standard Lookup will be filtered by only the values shown.

Scroll down and highlight the Scope area.

Some of the setup objects may not have predefined filters but you can still add one or more filter values to restrict
export to a smaller set of setup data. For example, Legal Entity does not have any predefined filters, however, you can
add filters.

In the Select Objects area select Legal Entity.

In the Scope area click the Add Scope (+) icon.

Since you’ve setup many legal entities but want to export only 1 of them, add it as the scope.

Search for the Spain legal entity.

Add the Spain legal entity. You can select additional legal entities, but this is all you need for now. Since you’ve finished
your selection, save and close.

Click Spain and then click Save and Close.

The selected legal entity is displayed in the bottom table. When you submit this export process, setup data of this legal
entities will be exported. Now go to the next step.

Click Next Step.

By default, the export process runs as soon as you submit it. However, you could choose to schedule it for a later time.
For now, keep the default option and submit the process.

Highlight each schedule option as you describe it.

You receive a warning that if you continue, the configuration package will be locked and exported using the definition
you have specified. You will no longer be able to edit this configuration package. If, in the future you want to export with
different scope, you will have to create a new configuration package. Click Yes to continue.
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Click Yes.

The configuration package you just created and submitted for export is shown here.

Highlight the configuration package.

When you select it, the Export and Import Processes table displays the details of the processes.

Scroll down and highlight the lower part of the window that displays the processes.

Click Refresh to see that the status of the export process you just submitted is In Progress. Continue to monitor it until it
completes.

Click Refresh.

The export process has completed successfully, so download the configuration package file, and save it in an
appropriate location. You will use this file later to import the setup data into the environment where you want to migrate
your setup.

Click Download Configuration File.

Save the file.

Watch the Importing Setup Data from Configuration Packages video next to learn how to import setup data from the
exported file.

Click Done.

Thanks for watching.

Setup | Export subset of setup data  

Watch video
 

Hi, my name is Dee. In this video, I’ll show you how to export a subset of setup data from an offering or functional area.
You will need the Application Implementation Consultant role to perform this activity.

Your company deployed Financials with some legal entities a while ago. Recently you introduced a new legal structure
that needs to deploy to production. To start, go to Setup and Maintenance in your test environment.

Click Setup and Maintenance.

Choose the Financials offering.

Click the Setup drop-down list and select Financials.

Select Legal Structures and create a new export setup data process.

In the Legal Structures row, click the Actions menu and select Export > Create New.

Since the last import of Legal Structures functional area into your production environment, you know for certain which
setup data has changed and which haven’t. You plan to migrate only the data that has changed.

Highlight the configuration package details.
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Therefore select All from the Show filter and uncheck the export column of all business objects whose data you want to
exclude from my export. Keep in mind that if any setup data of the business objects you exclude are prerequisites for
importing other business objects, then your import might fail if the prerequisite data is missing from the production
environment.

Click the Jurisdiction Function and deselect the Export checkbox.

If the export service associated with any business object you are excluding also exports other business objects, you
get a warning that setup data for those other business objects will not be exported either. If you select yes, Export
checkboxes of those other business objects will be unchecked as well.

Highlight the message and then click Yes. Exclude other objects from Application Profile value thru Tax Authority Tax
Profile.

Once you have completed selection of the business objects to export, submit the process.

Click Submit.

Monitor the status of the process until it shows as Completed, then click on the status to view the results.

Highlight the status. Then highlight values in the Summary section.

The setup data was exported excluding the selected business objects. The business objects that you excluded from the
export process are listed under Manual Task and the Reason is shown as ‘Excluded by user’.

Highlight Reason Excluded by user in the Manual Tasks section. Highlight the Total Objects for External Loading.

You can also download the Manual Task Report and use it during import as a reference of the business objects that you
excluded from the exported configuration package.

Click Actions and select Download > Manual Tasks Report.

Here is how the Manual Tasks Report displays the list of the business objects you excluded during export.

Highlight the Reason and the Perform Recommended columns.

Thanks for watching.

Setup | Export and import task setup data using CSV
files  

Watch video
 

Hi, my name is Mike. In this tutorial you’ll learn how to export and import setup data for a task using a CSV file.
Sometimes the setup data you need to enter is very simple or it's similar to existing data that you can duplicate. In these
cases, it takes less time to create and use a CSV file. To start, navigate to the Setup page and find the task you want to
set up.

Click Setup and Maintenance.

Choose Workforce Development.
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Choose Workforce Information.

Now make sure that Actions for your tasks are visible.

Click View and select Columns > Actions.

If you don't see the task you want to export the data for, Show All Tasks, then choose the appropriate task.

Click Show and select All Tasks.

Click Review Calendar Events Coverage.

These options are enabled if export and import are supported for a task.

In the Review Calendar Events Coverage row, click the Actions item and select Export to CSV file.

If Setup data had already been exported, the most recent export Setup data to CSV process would be listed first. Create
a new export. If you want to export the template but not the existing data in the environment, you could check this
option.

Highlight the Export only template field.

Click the Add button to add a scope.

Click Add.

If you want to export the existing setup data, you could filter the setup data based on the scope enabled business
objects. But we don't want to do this right now, so just Cancel, and then click Submit.

Click Cancel.

Because you didn't choose a scope value, all setup data relevant to this task will be exported.

Click Submit.

Now monitor the process until it completes. The most recent process is here at the top of the list.

In the Review Calendar Events Coverage row, click the Actions menu and select the current process.

Click View Process.

Click View Process.

Click the Refresh button until it changes to Download File.

Click Refresh.

If there had been any errors, they would be displayed here, but this looks great, so Download the CSV File.

Highlight the Summary area.

Download the file, unzip it, and open the CSV file.

Take a look at the CSV file and if needed, update the data per your requirements.

Scroll through the CSV file.

Ok, now you've finished modifying your setup data in the file, so upload the new version now. As with the export, start
on the Actions menu, and choose the file you want to upload.

Click Actions and select Import from CSV file > Create New.
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Select and upload the ZIP file that you downloaded previously.

Setup validates that the selected file contains setup data for the corresponding task, otherwise it will ask you to select a
different file.

Highlight the Details section.

Monitor the Process until it's done.

Click Actions and select Import from CSV file. Then choose the current upload process.

Here it is.

Highlight the Business Objects section.

If there had been errors they would show here, but it looks fine.

Highlight the Summary section.

And finally, open the task to verify that the data loaded correctly.

Click Go To Task, then click the task name.

The task loads correctly so we are done. And you're done! Thanks for watching.

Setup | Generate setup data reports  

Watch video
 

Setup | Import offering setup  

Watch video
 

Hi, my name is Dee. In this video, you will learn how to import your offering setup. You need the Application
Implementation Consultant role to perform this activity. Before you can import, you must first export your offering
setup as described in the Export Offering Setup tutorial.

To start, go to offering Setup.

Click Setup and Maintenance.

You’ve successfully exported the setup data of Supply Chain Planning and now you are ready to import it to another
environment.

Click Setup drop-down list and Supply Chain Planning.

Create a new import process. If you export setup data of an entire offering, you start the import process from the
offering.

31

http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:19904
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:19904
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:19898
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:19898


Oracle Fusion Cloud Applications
Applications Common Videos Questions and Answers

Chapter 1
Apps-Common Videos

Click Actions and select Import > Create New.

Next, select the configuration package file that contains the exported setup data that you want to import.

Highlight the Browse button.

First, open the file.

Navigate to and select the configuration package file.

Click Open.

The Configuration Package Details section shows the basic information about the exported file so you can verify
whether or not you have selected the correct file. If you need to, you can use the update button to select a different file,
but this looks good.

Highlight the Details section.

By default, the import process will pause if any errors are found during import, so you can take the corrective actions
before it continues. If you want, you can change this option and allow the process to run without pausing. However,
be aware that if any prerequisite data fails, additional dependent data might not be imported correctly. There might be
some data that can’t be imported automatically and requires you to import it manually. By default the import process
pauses each time data must be imported manually. You could change this option, if all data required to be imported
manually already exists in your environment. Highlight the Pause process each time an error occurs and the Pause
process each time manual import setup data is required checkboxes.

Although feature selection – that is, the opt-in configuration--is exported along with the setup data, it’s not
automatically imported. If you want to import opt-in configuration you have to explicitly select the Import Feature
Selection checkbox and then Submit.

Highlight the Import Feature Selection checkbox.

Submit the process.

Highlight the Submit button.

When you choose to import the opt-in configuration, a warning is displayed that the import will override the opt-in
configuration of the current environment. Confirm that this is what you want to do.

Click Yes.

When you choose to import the opt-in configuration, a warning is displayed that the import will override the opt-in
configuration of the current environment. Confirm that this is what you want to do.

Highlight the warning at the top of the page and then highlight the Pre-Import Tasks section.

These are the same manual tasks that you received a warning about at the end of the export processing. Ensure that
you’ve entered this setup data and then select Resume.

Click Resume.

Once you resume the import process, you receive a confirmation.

Highlight the Yes button.

The status of the import process is displayed on the setup page. Continue to watch the process until it completes.

Click the Status of the Import process.
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If any setup requires manual data entry during import, the process pauses and you didn’t change the default import
options, the status shows Waiting for manual import. Drill down to review what you have to enter manually.

Click the Status of the Import process.

Here you see that you have to grant user access to the Reference Data Sets manually. So, go to the appropriate page to
enter the data.

Highlight the Business Objects section.

Drill down on the task name.

Click the task name.

Once you complete you data entry, return to the Import Process page.

Click Done.

And resume the import process.

Click Resume.

Confirm that you want to continue.

Click Yes.

The Import process resumes. Now watch the process until it completes.

Highlight the process status once it starts again. Click the status when completed.

Review the summary of the process. The process was successful. Now review if there are any manual tasks that you
need to complete. If so, ensure they are correctly performed. Otherwise the offering will not be fully ready to be used.

In the Summary section, highlight the status.

Highlight the Manual Tasks section.

If the import process completes with errors, under the Business Objects section, the Status Details column displays the
error details, in which case, you’d review and take appropriate action to correct the errors.

Expand Business Objects.

Since this process completed successfully, you do not need any additional actions. However, it is a best practice to verify
correct data was imported for the setup objects. You can verify data before making the offering available to users.

Highlight the Business Objects section.

Expand the Business Objects section.

If you exported setup data of a functional area instead of an entire offering, you start the import process from the
functional area. For example, after your initial import of the entire offering, if you need to migrate setup changes for
Enterprise Profile you could export only that functional area. In that case, select Enterprise Profile from the list of the
functional areas and then create a new import process. The rest of the import process works the same for both the
offering and the functional areas.

Click the Suppliers drop-down list and select Import > Create New.

Thanks for watching.

33



Oracle Fusion Cloud Applications
Applications Common Videos Questions and Answers

Chapter 1
Apps-Common Videos

Setup | Import offering setup data from a CSV file  

Watch video
 

Hi, my name is Mike. In this video, you will learn how to import your offering setup from CSV Format. You need the
Application Implementation Consultant role to perform this activity. Before you can import, you must first export your
offering setup to CSV format as described in the Export Offering Setup tutorial. To start, go to offering Setup.

Click Setup and Maintenance.

You've successfully exported the Service setup data in a CSV format and now you are ready to import it to another
environment.

Click the Setup drop-down list and select Service.

You want to export setup data of an entire offering, so start the import process from the offering.

Click Actions and select Import from CSV File > Create New.

Create a new import process. Next, select and open the CSV file package that contains the exported setup data that you
want to import.

Click Browse.

Navigate to and select the configuration package file.

Click Open.

The Configuration Package Details section shows the basic information about the exported file so you can verify
whether or not you have selected the correct file. If you need to, you can use the update button to select a different file,
but this looks good.

Highlight the Details section.

By default, the import process pauses if any errors are found during import, so you can take the corrective actions
before it continues. If you want, you can change this option and allow the process to run without pausing. However, be
aware that if any prerequisite data fails, additional dependent data might not be imported correctly.

Expand Import Options and highlight the Pause process each time an error occurs checkbox.

There might be some data that can’t be imported automatically and requires you to import it manually. By default the
import process pauses each time data must be imported manually. You could change this option, if all data required to
be imported manually already exists in your environment.

Highlight the Pause process each time manual import setup data is required checkbox.

Submit the process now.

Click Submit.

Once you submit the import process, you receive a confirmation.

Click OK.
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Watch the process until it completes. The process status changes to “Waiting for manual import” if you need to enter
data manually during the import. Click on the status to see what data is required.

Click on the Status of the Import CSV File process.

These are the same manual tasks that you received a warning about at the end of the export processing. Ensure that
you’ve entered this setup data and then select Resume.

Click Resume.

Optionally, you can change the default import options per your needs. The import process resumes.

Click Yes.

Watch the process until it completes, then click on the status to check the results.

Click on the Status of the Import CSV File process.

Review the summary of the process. The process completed successfully. Review to see if there are any post-import
tasks.

Highlight the Summary section.

If any post import tasks are listed, ensure they are correctly performed - otherwise the offering will not be fully ready to
be used.

Highlight the Manual Tasks section.

It is a best practice to verify correct data was imported for the setup objects. You can verify data before making the
offering available to users. If the import process completes with errors, the Status Details column displays the error
details, in which case, you should review and take appropriate action to correct the errors.

Expand the Business Objects section.

If you exported setup data of a functional area instead of an entire offering, you would start the import process from
the functional area. For example, if after your initial import of the entire offering you need to migrate setup changes for
Service Request only, select your functional area, and create a new import process using an exported data file for the
corresponding functional area. The rest of the import process works the same for both the offering and the functional
areas.

In the Service Request row, click the Actions icon and select Import from CSV File > Create New.

Thanks for watching.

Setup | Import setup data from configuration packages  

Watch video
 

Hi, my name is Mike. In this video, you’ll learn how to import setup data from a Configuration Package. You need the
Application Implementation Consultant role to perform this activity. Before you can import, you must first export setup
data from an implementation project to create a configuration package as described in the Export Setup Data to a
Configuration Package video. To start, go to Setup and Maintenance.
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Click Setup and Maintenance.

Open the task panel and then select Manage Configuration Package.

Click on the task panel icon select Manage Configuration Package.

First, upload the configuration package file that you created by exporting setup data from an implementation project.

Click Upload.

Click Choose File and select the appropriate configuration package file from the location where you downloaded and
saved the exported file.

Click Browse.

Click Get Details to verify that you have chosen the correct configuration package file.

Click Get Details.

By reviewing information in the Configuration Package Details and the Implementation Project Details sections you
know that you have selected the correct file. If the file is not the correct one, you can update and select a different
configuration package file.

Highlight the Configuration Package Details and Implementation Details areas.

Since you don’t need to change to a different file, submit the upload process.

Click Upload.

If you previously uploaded a configuration package with this name, confirm that you want to replace it. Then, click to
dismiss the replacement information.

Click Yes.

Once the upload process is submitted, the configuration package is listed in the Search Results table.

Click the Configuration Package name in the table.

The related processes for the highlighted configuration package is displayed in the Export and Import Processes table.
The upload process you submitted completed successfully and is ready for import.

Click the Process in the process table.

Select the row that shows the upload process and then Import Setup Data.

Click Import Setup Data.

A process name is assigned by default but you can change the name to something more meaningful to make it easier to
identify later. By default, the import process pauses each time it encounters an error so that you can take the corrective
actions before import continues. If you want, you can allow the import process to continue without pausing. In that
case, you have to assume the risk that if import of any prerequisite data failed due to error, additional dependent setup
data might not be imported correctly. Keep the default setting and move to the next step.

Highlight the Import Options.

Some of the setup data might not be imported automatically and might require you to create or load it manually. Filter
the list of setup objects by Manual data loading type to find if any such setup objects are part of the configuration
package that you are preparing to import. There are some setup objects for which data will not be imported
automatically. You’ll have to enter those objects manually.
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In the Type field, select Manual Data Loading.

Notice that Reference Data Set User Data Access has a checkmark in the Pause column. That means, the import process
will pause while running and you have to enter this data manually before you can resume the import process. Where
the Pause column does not show a checkmark, you can enter their data before or after the import process starts or
completes. Move to the next step.

Highlight the Pause column.

Click Next.

By default, the import process runs as soon as you submit it. However, you could choose to schedule it for a later time.
For now, keep the default option and submit the process.

Highlight the Schedule fields.

Click Submit.

If any of the setup data that must be entered manually also has to be entered before the import process starts, a
warning message is displayed. In this case, you need to enter setup data for before you submit the import process.
If you have already created that data in this environment, choose Yes to submit. If not, then choose No and load the
requested data.

Click Yes.

Once submitted, the import process is listed in the Export and Import Processes table when the you select the
corresponding Configuration Package from the Search Results table above.

Select the Configuration Package.

Monitor the status of the import process until it completes. Refresh to get the latest status of the process.

Click Refresh.

The import process pauses and the status shows User Action Required when it encounters a setup object that requires
manual data entry while the process is running. Drill down on the status.

Click User Action Required.

Filter the Object Details table by User Action Required status to find the appropriate setup object.

In the Status field, select User Action Required.

Now go to the appropriate task to enter the setup data manually.

Click Go To.

After you've completed your data entry, which is not shown here, return to the Export and Import Process Results, and
select Resume to resume the import process.

Click Done. Navigate back to the process page.

Click Resume.

Now click Submit to restart the import process.

Click Submit.

Because the process paused for manual data entry, you must confirm that you have completed the manual task.
Continue to monitor until the process completes.
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Click Yes.

Drill down to the details to verify that all setup data was imported successfully. Check to see if any additional setup data
needs to be loaded manually. And if required, load it.

Click the status.

Now your setup has successfully migrated to this new environment. So, the environment is now ready for use.

Highlight the imported data.

Thanks for watching.

Setup | Manage setup using implementation projects  

Watch video
 

Hi, my name is Mike. In this video, You’ll learn how to manage your setup using an Implementation Project. You need
the Application Implementation Manager role to perform this activity. Before you create an implementation project,
you must first enable the offering and functional areas you want to implement as described in the Configure Offerings
tutorial. To start, go to Setup and Maintenance.

Click Setup and Maintenance.

Open the task panel and then select Manage Implementation Projects.

First create an implementation project.

Click Create (+).

You want to manage setup data for Purchasing for the Procurement offering, so change the name so you can easily
identify your implementation project later.

Change the name to Procurement Purchasing.

Optionally, you can assign the implementation project to a user and a start date. But you don’t want to do that now, so
go on to the next step.

Highlight the Assigned To and Start Date fields.

Click Next.

Now, select the offering and functional areas that you want to manage in this implementation Project.All offerings and
functional areas that you opted into are listed here. If an offering or functional area that you need isn’t shown, you can
opt into them as shown in the Configure Offerings video. Select Procurement, then Purchasing.

Highlight the corresponding offering.

Select the Include checkbox. Repeat for the corresponding functional area.

Since Purchasing has dependent functional areas, you can select them as well. But for now you only want to setup
Purchasing and so do not select those dependent functional areas. You’re done with your selection, so save and open
your implementation project.
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Highlight the Self Service Procurement and Supplier Invoice Processing rows.

Click Save and Open Project.

The task list for your implementation project is generated based on your offering and functional area selection. Expand
and review the list of tasks. You have all the tasks you need for your implementation, so now you can assign the tasks
to other users that will help with the implementation. Select the tasks you want to assign, and then click on the Assign
Tasks button.

Expand the Procurement node.

Highlight Procurement and the Purchasing task lists.

Click Assign Tasks.

Search for users. Add the users who have the responsibility to enter this setup data.

Search for and select Amy Marlin.

Add one more user, then click Apply, then done.

Search for and select John Kim.

Click Done.

You can specify a due date for each user to complete these tasks or, you can specify the same due date for all users.
You must be careful when specifying due dates and keep in mind the task sequence so you do not create any data
dependency conflicts.

Highlight the Due Date field for a specific user.

Click Assign Due Date to All Users.

Select a date.

Optionally you can add a note for the assigned users.

Highlight the Note field.

You have completed the assignments for these tasks, so save and close.

Click Save and Close.

Highlight Amy Marlin. Hover over 1 More to display John Kim.

Now your tasks are assigned and you can see who is assigned to each task. You can repeat the same steps to assign any
other tasks as needed, but these tasks are now ready for users to perform.

Click Done.

Thanks for watching.

Setup | Compare offering setup data changes over time  

Watch video
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Hi, my name is Mike. In this video, you will learn how to compare different versions of setup data of an offering
or a functional area.You will need the Export Import Functional Setups User role and the appropriate application
administrator role to perform this activity.

Your company deployed the Supply Chain offering in your environment a while ago and some changes have been
made since then. You’ve already exported this setup data when initially deployed and want to identify what setup
modifications have been made in your environment since then. To start, go to Setup and Maintenance in the
environment where you want to compare the data.

Click Setup and Maintenance.

Choose the Supply Chain Planning offering.

Click the Setup drop-down list and select Supply Chain Planning.

Create a new compare setup data.

Click on Actions and select Compare Setup Data > Create New.

You can compare the setup data in your environment against a previous version exported in the same environment
which will appear listed at the top. Or, You can select Upload New to upload a version you saved before from the same or
another environment and that you want to compare.

In the Configuration Package field select Upload New.

Browse and select the configuration package file that contains setup data you want to compare against.

Click Browse and select the Configuration Package.

The Configuration Package Details section shows the basic information about the exported file so you can verify
whether you have selected the correct file.

Highlight the Configuration Package Details section.

Now submit the upload process.

Click Submit.

Once the package is uploaded, it’s ready for comparing the setup data. Now you can choose between comparing
against the current data in this environment or another existing version in a configuration package.

Highlight the Source field and the available options in it.

In the Source field select Configuration Package.

Similarly, you can select any configuration package already available in the environment or select Upload New to upload
a version you want to compare.

Highlight the Configuration Package field and the available options in it.

In the Configuration Package field select Upload new.

Since you are interested in identifying the differences with the current data in the environment, then select Data in this
environment as the source.

In the Source field select Data in this Environment.

You can change the default process name before submitting the comparison process if you want.

Highlight the Process Name field.
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Click Submit.

Confirm the submission.

Click OK.

Monitor the status of the comparison process until the status shows Completed. Now view the comparison results.

Click the Status for the process.

Here’s a summary of all the objects processed and objects with discrepancies. If the process finishes with warnings, the
details include business objects that are not common to both configuration packages. That would be the case if new
functionality was opted in, but this finished without warnings.

Highlight the status.

Highlight the Comparison Summary section.

The objects with setup data discrepancies are listed by default, but you can change the selection to see all the objects
that were compared if you want to. You want to review only the discrepancies, so don’t change the selection.

Highlight the Show field and the available options in it.

The setup data is compared record by record for each business object. First check the Only in Configuration 1 column
to determine which records exist only in such configuration package which in this case is the previous version of my
environment.

Highlight the Comparison Details section.

Highlight the Only in Configuration 1 column.

Open the report for Functional Security Custom Roles.

Highlight the value under Only in Configuration 1 for Functional Security Custom Roles, then click it.

Here are the details of Functional Security Custom Roles that were in the previous version and not currently available in
the environment. This is what you were expecting, so you can return to your results.

Highlight values under Row Identifier and then close Excel.

Now, check the In Both with Mismatch column to review the records that exist in both the configuration package
from the previous environment and the current environment, but have different attribute values. There is 1Trading
Community Source System records that have mismatched values.

Highlight the value in In Both with Mismatch column for Trading Community Source System, then click it.

Open the report to review the details.

Highlight the row identifier. Highlight Value in Source 1 and Value in Source 2 for each pair.

The report contains two rows for each matching record: The first row shows the values from the first source which
in this case is the configuration package from a previous version. The second row shows the values from the second
source which in this case is the current data in my environment.

Highlight the columns with values and the differences between the value for source 1 and 2.

Freeze the first two columns in order to identify the records and sources, and then for each record, scroll to the right to
find out the discrepancies between the two sources. Values are only presented for the attributes with discrepancies, so
you can easily identify them.In this case, only the StartDateActive was updated. Return to the results.

41



Oracle Fusion Cloud Applications
Applications Common Videos Questions and Answers

Chapter 1
Apps-Common Videos

In Excel, click Freeze Panes and select Freeze the first two columns.

Next check the ‘Only in Configuration 2’ column to determine which records exist only in the current environment. Open
the report.

Highlight the Only in Configuration 2 column, Functional Security Custom Roles row, then click it.

These records only exist in the current environment, hence they were added since the version you compared against.
Return to the results and continue to review the discrepancies for the remaining objects until you complete your review.

Highlight the records and then close Excel.

Highlight the Done button.

Thanks for watching.

Setup | Compare offering setup data during import  

Watch video
 

Hi, my name is Mike. In this video, I’ll show you how to compare exported setup data of an offering or a functional area
before importing it. You will need the Application Implementation Consultant role to perform this activity. Your company
deployed the Financials offering to the production environment a while ago. Recently, you modified and verified the
setup of Payments on your TEST environment. You’ve already exported this setup data from TEST and now you’re ready
to import it into your PRODUCTION environment. But during import, you want to compare the exported data with the
existing setup data in the PRODUCTION environment to preview how setup data in Production will change after import
to avoid any unwanted overwrite.

To start, go to Setup and Maintenance in your production environment

Click Setup and Maintenance.

Click the Setup drop-down list and select Financials.

Now create a new import for the Payments functional area.

In the Functional Areas list, in the Payments row, click Actions and select Import > Create New.

Confirm that the offering setup data was previously imported. Select the configuration package file that contains setup
data of Payments, which you downloaded from your TEST environment.

If prompted, confirm that the offering was already imported.

Click Browse.

The Configuration Package Details section shows the basic information about the exported file so you can verify
whether or not you have selected the correct file.

Highlight the Configuration Package Details section.

Next specify that you want to Compare setup data before import. This allows the import process to run a comparison
of the existing data in the environment with the data that will be imported before the data is actually modified by the
import process. Now submit the import process.

42

http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:21868
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:21868


Oracle Fusion Cloud Applications
Applications Common Videos Questions and Answers

Chapter 1
Apps-Common Videos

Expand Import Options and select the Compare setup data before import checkbox.

Click Submit.

Confirm the submission.

Click OK.

Monitor the status of the Payments import Actions menu until the status shows Waiting for Comparison Review. Now
view the comparison results.

Highlight the Status for the process, then click it.

Here’s a summary of all the objects processed and objects with discrepancies. If the process finishes with warnings,
the details include business objects that are not common to both configuration packages. That would the case if new
functionality was opted in, but this finished without warnings.

Highlight the status.

Highlight the Comparison Summary section.

The objects with setup data discrepancies are listed by default, but you can change the selection to see all the objects
that were compared if you want to. You want to review the discrepancies, so don’t change the selection.

Highlight the Show field and the available options.

The setup data is compared record by record for each business object. First check to see which records exist only in the
configuration that you exported from the test environment. These are the records that will be created in the production
environment if you proceed with the import. Open the report for Payment System Transmission Value.

Open the report for Payment System.

Here are the details of the new Payment Systems that will be created if you import this configuration package. This is
what you were expecting, so you can return to your results.

Display the report results, then close Excel.

Now, check the In Both with Mismatch column to review the records that exist in both the configuration package from
test environment, and the production environment, but have different attribute values.There is 1 Internal Payer Value
record that has mismatched values. Open it to review the details.

Highlight the In Both with Mismatch column.

In the Payment System row, In Both with Mismatch column, click the value to open the report. The report contains
two rows for each matching record: The first row shows the values from the first source which in this case is the
configuration package from the Test environment. The second row shows the values from the second source which in
this case is the production environment. Freeze the column headers and the first two columns in order to identify the
records and sources, and then for each record, scroll to the right to find out the discrepancies between the two sources.
Values are only presented for the attributes with discrepancies, so you can easily identify them. Continue scrolling to the
right to determine if there are any other updates. Ok, no more attributes were updated. If you import this configuration
package from Test, then this record will be updated in your production environment. Return to the results.

Freeze the header row, scroll slowly through the report, then close Excel.

Next, check the Only in Configuration 2 column to determine which records exist only in the production environment.
If you import the configuration package from Test, the import process will not change these records in the Production
environment. Note that the import process never deletes records. Open the report to see the details.

Open the Payment Systems Transmission Value report.
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Once you review the details, if you determine that these records should be removed from the Production environment,
then you have to delete them manually.

Scroll through the report then close Excel.

Continue to review the discrepancies for the remaining objects until you complete your review.Based on your findings,
decide whether or not you will import this configuration package from your Test into your production environment.
If you’re satisfied with the changes that will occur in the production environment, use Continue to Import to start the
import process.

Highlight the Continue to Import button.

If you’re satisfied with the changes that will occur in the production environment, use Continue to Import to start the
import process. On the other hand, if you determine that the import will cause undesirable modifications to the setup
data in the Production environment, use ‘Cancel Process’ to cancel the import process.

Click Actions and highlight the Cancel Process button.

Thanks for watching.

Setup | Compare setup data using configuration
packages  

Watch video
 

Hi, my name is Mike.

In this video, you’ll learn how to compare setup data in a configuration package from your source environment to that in
the target environment before importing the configuration package.

You will need the Application Implementation Consultant role to perform this activity.

Before you can compare, you must first export setup data from your source environment and upload the configuration
package into the target environment.

You must also run export and create a configuration package with the setup data of the target environment.

Review the ‘Exporting Setup Data to Configuration Packages’ video for more information on how to export into
configuration packages.

To start, go to Setup and Maintenance

Open the task panel and then select Manage Export and Import Processes

Compare the setup data.

You want to import setup data from your Test into your Production environment.

You’ve already uploaded the exported configuration packages for your Test environment to this environment.

You’ve also run an export to create a configuration package with the same setup objects in this environment.

So now you’re ready to compare them and create a new comparison process.
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Select the uploaded configuration package from your Test environment as Source 1.

Next select the configuration package from the export process you previously ran on this production environment as
Source 2.

After you make your selection, the process name is set by default as a combination of the two configuration packages.

However, you can change it if you want to give a more meaningful name.

Submit the process now.

Once submitted, the process is listed at the top of the table and the Status column displays the current status.

Periodically refresh the page and continue to monitor the status until the process finishes.

Now that the process has finished, view the process details.

It is important to review the process details if it does not complete successfully.

For example, if the configuration packages you selected for Source 1 and Source 2 were from exports of very different
setup data objects, then the process completes with warnings and the process details show all of the business objects
that are not common in the selected configuration packages.

In this case, the process completed successfully, so you don’t have to review the details.

Review the comparison results.

The objects with setup data discrepancies between the two configuration packages are listed by default, but you can
change the selection to see all the objects that were compared if you want to.

You’re only interested in the discrepancies, so you don’t have to change the selection.

First check the Only in Source 1 column to determine which records exist only in the configuration package from the
Test environment.

If you import this configuration package, these records will be created in the Production environment.

Take a look at the details of the new Disbursement Payment Method.

Open the report using Excel.

The Disbursement Payment Method will be created here if you run import with this configuration package.

Return to the results.

Next check the ‘Only in Source 2’ column to determine which records exist only in Production.

If you import the configuration package from Test, the import process will not change these records in the Production
environment.

The import process never deletes records.

For example, this only exists in Production but not in the configuration package from Test.

Open the report to see the details.

If you determine this record should be removed from the production environment, then you will have to delete it
manually

Finally, check the ‘In Both with Mismatch’ column to review the records that exist in both but have different attribute
values.
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Review the details.

The report contains two rows for each record.

The first row shows the values from the first configuration package, which in this case is the Test environment.

The second row shows the values from the second configuration package, which in this case is the Production
environment.

The configuration package names are shown at the top of the report for your reference.

Freeze the column headers and the first two columns in order to identify the records and packages, and then for each
record, scroll to the right to find out the discrepancies between the two sources.

Values are only presented for the attributes with discrepancies, so you can easily identify them.

In this case only the Format Value was changed.

If you import this configuration package from Test, then this value will be updated in the production environment.

Continue to review the discrepancies for the remaining objects and close the page when you finish.

Based on your findings, decide whether or not to import this configuration package from your Test into your Production
environment.

Watch the Import Setup Data Using Configuration Packages video for details on how to import setup data.

Thanks for watching.

Setup | Compare task setup data  

Watch video
 

Hi, my name is Mike.

In this video, I’ll show you how to compare exported setup data of a task before importing it.

You need the Export Import Functional Setups User role and a role with the task-specific privilege to perform this
activity.

Recently, I modified the setup of Payments on a test environment, and now I’m ready to import it into my production
environment.

Before import, I want to compare the exported data from test with the existing setup data in the production
environment.

To start I’ll navigate to the Setup page and find the task for which I want to compare data.

To start I’ll navigate to the Setup page and find the task for which I want to compare data.

I’ll make sure that the Actions for my tasks are visible.

If you don’t see the task that you want to compare data for, show All Tasks.

In this case, we'll choose Manage Formats.
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These actions are available if comparison is supported for a task.

I’ll create a new Compare Setup Data process.

Next I’ll select the CSV file package which I downloaded from my test environment as the and upload it as Configuration
1.

The Configuration Package Details section shows the basic information about the exported file so that I can verify
whether or not I have selected the correct file.

Now I can choose to compare against the existing data in the environment or against another CSV file package for the
same task.

Since I want to compare the existing data in the environment with the data from the file I exported from my test
environment, I’ll leave the source selection unchanged and submit the process.

A confirmation message indicates that the comparison process has been submitted.

I will monitor the status of the Manage Formats comparison from the Actions menu until the status shows Ready for
Comparison Review.

Now I’ll view the comparison results.

Here’s a summary of all the objects processed and objects with discrepancies.

The objects with setup data discrepancies are listed by default, but I can change the selection to see all the objects that
were compared if I want to.

I’m interested in reviewing the discrepancies, so I won’t change the selection.

The setup data is compared record by record for each business object.

The common records to both sources are identified by matching their key attributes and then compared to identify their
discrepancies.

First I’ll check the Only in Configuration 1 column to determine which records exist only in the exported CSV files from
the Test environment.

If I import this CSV file package, these records will be created in the production environment.

I will open the report for Payment Process Format to see the details.

Here are the details of the new Payment Process Formats that will be created if I import this CSV file package.

That’s what I was expecting, so this is fine. Now I’ll return to my results.

Now, I’ll check the ‘In Both with Mismatch’ column to review the records that exist in both the CSV file package from test
environment and the production environment, but have different attribute values.

There is 1 Payment Process Format record that has mismatched values.

I’ll open it to review the details.

First. I'll freeze the first column.

Now I'll scroll across to review my data.

If I import this CSV file package from Test, then this record will be updated in my production environment.

I’ll return to the results.
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Next I’ll check the ‘Only in Configuration 2’ column to determine which records exist only in the production
environment.

If I import the CSV file package from test, the import process will not change these records in the production
environment.

Note that the import process never deletes records.

As a best practice, I always open the report and review the details.

In this example, I see that two records exists for this object.

Once I review the details, if I determine that these records should be removed from the Production environment, then I
have to delete them manually.

I will continue to review the discrepancies for the remaining objects until I complete my review.

If I’m satisfied with the changes that will occur in the production environment, I will use this file to start an Import from
CSV File process.

Thanks for watching.

Setup | Configure offerings  

Watch video
 

Hi, my name is Mike. In this video, you’ll learn how to configure the offerings that you have decided to use. You must
have the Application Implementation Consultant role to perform this activity. To start, navigate to Offerings.

Click My Enterprise.

If an offering is not enabled, you must go to the Opt In page to enable it. In this case, the Workforce Development
offering is already enabled.

Click Offerings.

If an offering is not enabled, you must go to the Opt In page to enable it. In this case, the Workforce Development
offering is already enabled.

Click Workforce Development.

You want to review the current status of the features of the Workforce Development offering and make some changes.
Start by clicking Opt in Features.

Click Opt In Features.

The Opt In page shows the offering and its functional areas in a hierarchy to make it easier to decide what to opt in. The
first row shows the Offering and the subsequent rows show its functional areas. If sub functional areas exist they are
shown underneath their parents.

Highlight as you describe each part of the hierarchy.

To opt in, select the Enable checkboxes of the offering and the functional areas you want to use.
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Highlight the Enable column.

Before a functional area can be opted in, its parent must also be opted in. So, unless you have already enabled Human
Resources Business Intelligence Analytics, you cannot enable any of its children.

Highlight the Human Resources Business Intelligence Analytics row, then highlight its children.

When a functional area supports opt in of more detailed features, an edit icon is shown in the Features column. Opt in
Career Development and review its Features.

Click the Edit Features icon.

When a functional area supports opt in of more detailed features, an edit icon is shown in the Features column. Opt in
Career Development and review its Features.

Highlight hierarchy as it's being described.

In some cases, a Feature has multiple choices to pick from and therefore shows an edit icon in the Enable column. The
Completed Goal Edit Option is currently set to ‘Never’, but you want to review the choices and decide if you need to
change it.

Highlight Never.

Click the Edit icon.

Never is the right choice for your company, so you leave it as-is.

Click Cancel.

The Selected Choices column shows any choices that are already selected. Some multiple-choice features allow you
to select more than one choice. In those cases, the Selected Choices column shows all of the choices that are currently
selected.

Highlight the Selected Choices column.

Hover over a selected choice that has multiple options selected.

The configuration of the rest of the features looks good, so return to the Opt In page.

Click Done.

Sometimes a functional area or feature is shown with the Enable checkbox already marked and set as read-only. In that
case, the parent represents a core functionality and therefore, must be used. However, you are able to opt in or out of its
sub functional areas and features as usual.

Highlight Workforce Information.

If the ability to opt-in will be discontinued in the future, the Always Enabled From column shows the software revision
from which it will be required.

Highlight the Always Enabled From column.

Now that you have finished enabling the functional areas and features you want to use, you can start to set up the
offering. Please watch the Performing Tasks video tutorial next to learn how to set up an offering.

Click Done.

Thanks for watching.
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How do I create a sandbox?  

Watch video
 

Title and music.

In this video, you’ll learn how to create a sandbox.

You can use sandboxes to make changes without affecting other users. For example, you can change the look and feel
of your application using the Appearance work area or add a page component using the Page Composer tool. Then you
can test your changes before publishing the sandbox to the main environment.

To start, navigate to the Sandboxes work area.

From the Home page, click the Navigator menu.

Expand the Configuration section.

Click Sandboxes.

You can view Available, Published, and Deleted sandboxes. Now let's create a sandbox.

Click Create Sandbox.

Enter a name for the sandbox.

In the Name field, enter Vision_Sandbox.

Specify whether you want to publish this sandbox. If you set the Publishable option as No, you can use your sandbox for
testing purposes only, but can never publish it. In this example, let’s create a publishable sandbox.

In the Publishable field, select Yes.

In the All Tools section, select the tools you want to activate for this sandbox. By default, the context layer for all tools
is set as Site. So, the changes you make using these tools affect all users. In this example, let’s select Appearance,
Structure, and Page Composer.

For Appearance, click the Active check box.

For Structure, click the Active check box.

For Page Composer, click the Active check box.

Now that you’ve selected the tools you want to use, create and enter the sandbox.

Click Create and Enter.

Your sandbox is activated, and you can see its name on the sandbox bar. You can use the options on the sandbox bar to
quickly do some activities, such as view sandbox details, publish the sandbox, or leave the sandbox. To view the tools
you activated in your sandbox, click Tools.

After making the application changes using the tools you activated, test your changes in preview mode before actually
publishing the sandbox. If you made changes using Page Composer, don't forget to close it before testing.
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Then publish your sandbox to make your changes available to all users.

For more information on this topic, you can view the course on Oracle University or reference the available guide on
Oracle Help Center.

Thanks for watching.

Oracle copyright and music.

How do I modify text using the user interface text tool?  

Watch video
 

Title and music.

In this video you'll learn how to use the User Interface Text tool to modify text in your application. For example, you can
change the phrase “Review Period” to “Assessment Period” throughout the application.

I start signed in as an administrator who has a role that includes both the Administer Sandbox privilege, which is
required to work with sandboxes, and the Manage User Interface Text privilege, which is required to use the User
Interface Text tool. I’m already in a sandbox that includes the User Interface Text tool. Navigate to this tool.

In the Sandbox tool bar, click Tool.

Click User Interface Text.

In the user interface text tool, enter the word or phrase you want to replace; for example, "Review Period", and the text
you want to replace it with; for example, "Assessment Period". You have options for your search, including making the
search case-sensitive using Match Case or using complete matching using Match Complete Word or Phrase. For this
example, I'll enable case sensitivity to reduce the number of results. You can select the language in which you want to
modify your text, and the types of application components you want to modify text for. For this example I'll select all
four so I can replace "Review Period" throughout the application.

In the Find field, enter Review Period.

In the Replace field, enter Assessment Period.

Select the Match Case check box.

In the Language drop-down list, select American English.

In the Type field, select Enterprise Scheduler Text. The User Interface Text, Global Menu Label Text, and Multipart
Validation Messages check boxes are already selected.

Click Search.

In the search results, you have four tabs. Under each tab, you can review or even edit the replacements that will be made
and exclude any that you don't want. Notice that since you didn't select the "Match Complete Word or Phrase" checkbox
the results include phrases such as "Salary Review Period" or "Number of Days After Current Review Period Start Date".
For this example, you'll only replace Review Period. There is no Global Menu Label Text. You won't modify the message
since you're not modifying Review Period name, and there is no Enterprise Scheduler Text. Once you've reviewed the
proposed changes, start the process to replace the strings.
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In the Exclude menu, select All.

In the Exclude column, deselect the Review Period check box.

Click the Global Menu Label Text tab.

Click the Messages tab.

In the Exclude column, select the You must provide a value for the Review Period Name attribute check box.

Click the Enterprise Scheduler Text tab.

Click Replace Strings.

Once the process completes, navigate to an application area and check the string replacement. For this example,
you'll check the Performance area, as those pages have many instances of the phrase "Review Period" and you can
quickly see what's changed and what hasn't. Notice that I'm stopping here for a moment so you can notice that "Review
Periods" hasn't been replaced. The text replacement tool treats your search text value as a whole word, so plurals aren’t
included. If you're trying to replace both singular and plural strings you may either use a wild card in your search or run
the tool twice.

Click the Home icon.

Click My Client Groups.

Click Performance.

In the Setup Maintenance section, review the Review Periods task.

Proceed to affected application pages and verify that the strings have been replaced, as expected. Once you verified
that the strings had been replaced in all application areas, you would publish the sandbox to make your changes
available to the users.

In the Administration section, click Performance Documents.

Review the page for references of the words "Review Assessments".

You’ve successfully modified your application text using the User Interface Text tool.

For more information on this topic, you can view the courses on Oracle University or reference the available guides on
Oracle Help Center.

Thanks for watching!

Oracle copyright and music.

Related Topics
• How do I create a sandbox?

Setup | Enter setup data using assigned tasks  

Watch video
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Title and music.

Hi, my name is Mike. In this video, you’ll learn how to enter setup using assigned tasks. You need the Functional Setup
User role and the appropriate security privilege to perform each assigned task.

To start, go to Setup and Maintenance

Click Setup and Maintenance.

Open the task panel and then select Assigned Implementation Tasks.

Click the Task panel icon.

Here are all of the tasks assigned to you that you haven’t completed yet. You can change the default selection if you
want to find a specific task.

Highlight the status filter.

Click Manage Disbursements Lookups.

In the Lookup Type field, search for IBY.

The tasks are ordered by due date and task sequence within the implementation project.

Highlight the Due Date, Task, and Project columns.

Some data might depend on other setup data so perform the setup tasks in the sequence they are listed in order to
prevent data dependency issues. Go to the first task.

In the Manage Functional Area Catalogs task row, click the Go to Task icon.

In this case, start by searching for the lookup code, then enter the appropriate setup data. Save your changes after you
have finished your task.

Click Done.

Now update the status of the task.

In the Manage Functional Area Catalogs task row, click the Status icon.

You can change the status as needed.

In the Status field, select Completed.

Optionally you can add a note to explain the progress or to communicate important information when you revisit the
task. Save the task now.

Highlight the Note field.

Click Save and Close.

Now that you've marked the task as Completed, it won’t be listed the next time you view this page or if you refresh the
page. Refresh the page now.

Highlight the Status field.

Refresh the page.

The task is not listed as Open anymore. Continue entering setup data for the next task in the list until you complete your
assignments. After you’ve performed all of your assigned tasks, click Done.
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Highlight the Manage Functional Area Catalogs task row.

Thanks for watching.
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